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Terms and Conditions

Thank you for buying this Topcon product. This manual has been
prepared to assist you with the care and operation of the product and
its use is subject to these Terms and Conditions and those more fully
set forth in the Operator’s/User’s Manual.

Usage and Safety

This product is designed for use by professionals. Always use safety
precautions when operating this or any Topcon product.

Copyrights and Trademarks

The information in this manual is a copyright of Topcon and is for use
only with the product. GR-5, TRU, TopSURYV, Topcon Link, Topcon
Tools, and Topcon are trademarks or registered trademark of Topcon
Positioning Systems, Inc. Windows and the Windows CE icon are
registered trademarks of Microsoft Corporation.

Other product and company names mentioned herein may be
trademarks of their respective owners.

Disclaimer of Warranty and License
Agreement

Please see the Operator’s/User’s Manual for detailed information on
warranties and the license agreement which may apply to the Product.
EXCEPT FOR SUCH WARRANTIES AND LICENSES PROVIDED WITH
THE PRODUCT, THIS MANUAL AND THE PRODUCT ARE PROVIDED
“AS-IS”. TOPCON AND ITS DISTRIBUTORS SHALL NOT BE LIABLE
FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED
HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS
MATERIAL OR THE PRODUCT.

Use of any computer programs or software supplied by Topcon or
downloaded from the Topcon website in connection with the Product
implies acceptance of the Terms and Conditions here and in the
Operator’s/User’s Manual.
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Chapter 1

¥ Biroduction

This quick start guide focuses on how to get your GR-5 up
and running quickly without overwhelming you with
technical details.

Chapter Descriptions

Chapter 1: Introduction (this chapter)

Understand the GR-5 parts and features, default
configuration, and accessories available for your GR-5
receiver.

Chapter 2: Getting Started

Explore preliminary steps to get your GR-5 ready for
surveying.

Chapter 3: Survey

Learn the basic survey procedures.

Chapter 4: Downloading Files

Transfer field data to your post-processing software.
Chapter 5: Maintenance

Help you use the GR-5 productively and safely.
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« Chapter 5: Troubleshooting

Provide tips and solutions for potential problems during
GR-5 operation.

Where to Find More Information

* For detailed information regarding features, capabilities,
and software introduced with this receiver, refer to the
GR-5 Operator’s Manual (7010-1004).

* For the quick guide about GR-5 cellular modem, refer to
the GR-5 Cellular Modem Quick Start Card
(7010-1013).

* Visit Topcon University at www.topconuniversity.com
for webinars and training opportunities. The TU website
also provides you with access to software and firmware,
manuals, and more to help you maximize your technical
and industry knowledge and skills.

Topcon GR-5 Quick Start Guide



Getting to Know Your GR-5

Getting to Know Your GR-5

MINTER

The MINTER is the receiver’s minimum interface used to
display and control data input and output.
RX TX

\\ [ r

& @ & D ®

4 \
Battery Battery
Power FUNCTION

Button Button

The battery LEDs display the power status for each
battery:

* Green — indicates greater than 85% charge.
* Orange — indicates an intermediate charge.

* Red - indicates less than 15% charge.

The STAT LED displays the status of tracked satellites.

* Red blink — receiver is on, but no satellites being
tracked.
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» Green blink — receiver is on and tracking satellites; one
blink per tracked GPS satellite.

* Orange blink — receiver is on and tracking satellites; one
blink per tracked GLONASS satellite.

The REC LED displays the data recording status.

* Green blinks — each blink indicates that data is being
written to the SDHC card.

* Solid Orange — the receiver is changing modes.

* Orange blinks — the receiver is checking its internal file
system. During this operation, the file system is not
accessible for CDU (control display unit) applications
or for data recording. This operation may require from
fractions of a second to several minutes, depending on
the circumstances and the amount of internal memory.

¢ Solid Red — a fault condition with the receiver (no more
memory, no SDHC card inserted, a hardware problem,
or an improper OAF).

Topcon GR-5 Quick Start Guide



Getting to Know Your GR-5

The RX TX LED displays the status of the modem.
Table 1-1 describes the LED colors and patterns for the
different modems available for the GR-5 receiver.

Table 1-1. RX TX LED Indications

FH915 Plus/
Digital/Satel
Modems

No light — modem is turned off.
Green flashes — modem is in receiver mode.

Solid Green — a radio link has been established;
modem is ready to receive data.

Solid Green plus Red flashes — modem is receiving
data.

Solid Red — modem is in transmitter mode.

Red flashes — a fault condition has been detected.
Check the condition of the radio modem’s antenna to
ensure it is undamaged, and is connected properly and
securely. Also make sure nothing interrupts the signal.

Red flashes plus Green flashes — modem is in
command mode.

GSM/GPRS

Solid Orange (Red and Green) — the modem is
initializing.

Green flashes — the modem is on, registered on the
network, and is waiting for incoming calls (Slave
mode).

Solid Red — a connection has been established.

Green flashes — the modem is in direct control mode
(Daisy Chain).

Orange flashes — an error has occurred (initialization
error, wrong PIN code, and so forth).
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The BT LED indicates the level of activity at the Bluetooth
wireless technology communication link:

¢ Blue flashes — the Bluetooth module is on but no
connection is established.

* Solid blue light — the Bluetooth module is on and a
connection has been established.

* No light — the Bluetooth module is off.
The power button turns the receiver on and off.

The FUNCTION button switches the receiver between
information modes and post-processing modes, starts/stops
data recording, and changes the baud rate of the serial port A
to 9600. Table 1-2 on page 7 describes the REC LED status
when using the FUNCTION button.

Topcon GR-5 Quick Start Guide
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Table 1-2. FUNCTION Button Operations and REC LED Status

FUNCTION
Key

REC LED

Status

When data recording is off, and the FUNCTION key is...

Not pressed

No light No data recording.

Orange Internal file system test in progress.
blink

Red No free memory; hardware problem with

data recording. No SDHC card.

If FUNCTION key mode is “LED blink mode switch”

Pressed for

Orange

Release to change information mode.

< 1 second

If FUNCTION key mode is “Occupation mode switch”

Orange

No function.

If FUNCTION key mode is “LED blink mode switch”

Pressed for
1-5 seconds

Green

Release to start data recording (post-
processing occupation mode undefined).

If FUNCTION key mode is “Occupation mode switch”

Green

Release to start recording (Kinematic or
Static post-processing occupation mode).
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Table 1-2. FUNCTION Button Operations and REC LED Status

> 8 seconds

FUNCTION REC LED Status
Key
Pressed for Red Release to turn serial port A baud rate to
5-8 seconds 9600 bps.
Pressed for No light No function.

When data recording is on, and the FUNCTION key is...

Not pressed

Red

No free memory; hardware problem with
data recording.

If FUNCTION key mode is “LED blink mode switch”

Green

Data recording started (post-processing
occupation mode undefined).

If FUNCTION key mode is “Occupation mode switch”

Green Data recording started (Kinematic post-
processing occupation mode).
Orange Data recording started (Static post-

processing occupation mode).

Topcon

GR-5 Quick Start Guide



Getting to Know Your GR-5

Table 1-2. FUNCTION Button Operations and REC LED Status

FUNCTION

REC LED Status
Key

If FUNCTION key mode is “LED blink mode switch”

Pressed for Orange Release to change information mode.

< 1 second

If FUNCTION key mode is “Occupation mode switch”

Orange Release to toggle between Static and
Kinematic post-processing modes.

Pressed for No light Release to stop data recording.

1-5 seconds

Pressed for Red Release to turn serial port A baud rate to
5-8 seconds 9600 bps.

Pressed for No light No function (data recording still on).

> 8 seconds

Data and Power Ports
The GR-5 has the following three ports:
¢ USB - rimmed in yellow; used for high-speed data

transfer and communication between the receiver and an
external device.
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¢ Serial Port A — rimmed in black; used for
communication between the receiver and an external
device.

¢ Power — rimmed in red; used to connect the receiver to
an external power source. This port can also be used to
charge the batteries.

USB Serial A Power
(yellow) (black) (red)

/
Y [

The following ports are used internally:
¢ Serial Port B — left free in the current release.

¢ Serial Port C — connect the modem and receiver boards.
Note that the GSM/GPRS/CDMA modem is located on
the RF modem board.

e Serial Port D — connect the receiver board and Bluetooth
module. Note that the Bluetooth module is located on
the RF modem board.

Topcon GR-5 Quick Start Guide
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Radio Antenna and Pole Connectors
The SS antenna connects to the external antenna connector
on the GR-5 radome. The radio antenna uses a reverse
polarity TNC connection or BNC connection depending on
the installed radio modem.
The bottom connector connects the receiver to either a
standard 5/8" thread pole/adapter or the quick disconnect.

External
Antenna
Connector

A)m Connector for

Standard Setups

SDHC and SIM Card Slots

The SDHC and SIM card slots reside under the batteries near
the base of the dome.

The SDHC card slot is located to the left of the MINTER
inside the battery pocket and connects an optional SDHC
card to the receiver board to provide memory. The data that
resides on the SDHC card can be accessed via the USB or

P/N 7010-1022 www.topconpositioning.com



Introduction

serial port, or Bluetooth. The following industrial-grade
cards were tested in the temperature range -30°C to 60°C (-
22°F to 140°F).

e Transcend® Ultra Industrial 2 GB
¢ APRO® Industrial 4GB
e SanDisk® Ultra II

¢ Swissbit® Industrial 2GB

Before using any other SDHC cards, consult with TPS
technical support about compatibility.

The SIM card slot is located to the right of the MINTER
inside the battery pocket and allows a standard SIM card to
be installed in the receiver. Once installed, the SIM card
provides a unique identification for the receiver’s GSM
module and enables the receiver’s GSM functionality based
on the subscribed services. The GSM module with the SIM
card installed can be configured via TRU. A SIM card can be
purchased from a local cellular provider.

Topcon GR-5 Quick Start Guide



Default Configuration

Battery

SDHC Card

Battery

Default Configuration

The GR-5 is shipped from the factory with the default
configuration. The following table shows the major default
settings for the GNSS board.

Parameter Default Setting
MINTER:
Recording interval 1 second
Elevation mask 5 degrees
Filename prefix log
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Parameter Default Setting
Tracking:
Elevation mask 5 degrees
GPS tracking enabled”
GLONASS tracking enabled”
SBAS tracking disabled”
Positioning:
Mode standalone
Elevation mask 5 degrees
PDOP mask 30
GPS usage enabled”
GLONASS usage enabled”
Multipath reduction enabled”
Raw measurement update rate 100* ms
Position update rate 100" ms
Datum Wwa4

Topcon GR-5 Quick Start Guide
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Parameter Default Setting
RTK:
Position output mode Delay
Ambiguity fixing level Medium
Max number of SVs in RTK 20
Minimum C/A SNR 31 dB*Hz
Min number of SVs for fixing | 5
ambiguities
Max extrapolation time 30 seconds
Serial Ports (A, B, C, D):
Input mode Command
Baud rate 115200
Hardware handshaking Disabled
Stop bits 1
Parity No parity
Data bits 8

*. Some of the default settings depend on the
options available in the OAF for your GR-5
and may differ from the published values.

P/N 7010-1022
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The modem default settings vary greatly depending on the
modem type, country of usage, etc. Consult the Operator’s

Manual for details.

Accessories
The following accessories are available for the GR-5
receiver.
Accessory Part Number Description
Cables

Power cable

U.S. 14-008052-01
Europe 14-008054-01
Australia 14-008053-01

Connects the power
supply unit to a
grounded outlet.

Receiver power/

14-008016-03

Connects the receiver

charging cable and the power supply
unit via SAE
connectors for battery
charging.

USB cable 14-008070-01 Connects the receiver

to an external device
(controller or
computer) for high-
speed data transfer
and receiver
configuration.

Topcon

GR-5 Quick Start Guide
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Accessory

Part Number

Description

Serial cable

14-008005-02

Connects the receiver
to an external device
(controller or
computer) for data
transfer and receiver
configuration.

ODU-to-alligator
clips cable

14-008097-01LF

Connects the charging
cradle or receiver to
an auxiliary battery
for powering the
receiver during survey
operations.

Cradle-to-

14-008072-01

Connects the receiver

receiver charging (1.5m long) to the charging cradle

cable 14-008072-02 for external power.
(0.5 m long)

Chargers

Power supply 22-034101-01 Charges the batteries.

unit

Charging Cradle 01-050911-01 Charges the batteries.

Antennas

SS/GSM antenna | 30-030012-01 The Spread Spectrum

and GSM antenna.

P/N 7010-1022
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Accessory Part Number Description
UHF/GSM 30-070003-01 The UHF and GSM
antenna UHF 410-440 antenna.

30-050503-01
UHF 450-470

Tripods, Poles, Adapters

Tripod 22-050501-01 The heavy duty
tripod.

Pole 22-050908-01

Universal 22-006008-01 Used to level the

tribrach and 22-006009-011 tripod and secure the

tribrach adapter receiver or antenna to
the tripod.

Precision tribrach Used to precisely

adapter center, align, and
level the tripod over a
point.

Quick disconnect | 02-850905-01 Connects to the range

adapter pole for the receiver

to slip into the top.

Topcon GR-5 Quick Start Guide
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Accessory Part Number Description
Miscellaneous
AA battery pack Holds four AA
batteries to provide a
portable backup

power source for the
receiver

P/N 7010-1022
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Notes:
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Chapter 2

ﬂtting Started

This chapter describes the activities you normally need to
take when you start using the GR-5 for the first time or
before beginning to survey with the GR-5 receiver,
specifically:

* installing configuration software

* turning the receiver on and off

* inserting SDHC and SIM cards

* charging and attaching batteries to the receiver

» connecting the receiver and an external control device

Installing Software

The Topcon GPS+ CD includes the following software
programs used for configuring and maintaining the receiver.
This software is also available on the TPS website to
registered users.

If installing the program(s) from the GPS+ CD, insert the
CD into the computer’s CD-ROM drive. If downloading the
program(s) from the website, extract the program’s files into
a folder on the hard drive.
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Installing PC-CDU

1.

4,

Create a PC-CDU folder on the hard drive and place the
compressed PC-CDU zip file (retrieved from either the
website or the GPS+ CD) in this folder.

Navigate to the PC-CDU folder and double-click the
PCCDU_MS zip file.

Extract the PCCDU.EXE and associated *.dll file to the
PC-CDU folder.

Create a shortcut on the computer’s desktop for quick
access to PC-CDU.

To uninstall PC-CDU, navigate to the location of the *.exe
file. Select the file and press Delete.

Installing TRU

1.
2.
3.

Navigate to the TRU folder, and double-click TRU.zip.
Extract TRU.exe to the TRU folder.

Double-click TRU.exe to run the installer, and then
follow the on-screen instructions.

After installation, shortcuts appear on the desktop and in the
TRU menu.

To uninstall TRU, use Add or Remove Programs in
Windows’ Control Panel. navigate to the location of the

* exe file.

Topcon GR-5 Quick Start Guide
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Turning On/Off the Receiver

To turn ON the receiver, press and hold the power button
until the LEDs briefly flash.
To turn OFF the receiver, press and hold the power button

for more than one and less than four seconds (until both the
STAT and the REC LEDs are off).

Installing the SDHC Card

The SDHC card provides memory space in which to save

logged data. Although you may install an SDHC card of any

size, the receiver will recognize only up to 2 GB of memory.

Always initialize the file system on the installed SDHC card

before the first use. Initialization procedure is described in

“Initializing File System” on page 51.

1. Ensure the receiver is turned off.

2. Remove the battery to the left of the MINTER.

3. Carefully insert the SDHC card, label side down, into
the SDHC card slot located at the top of the battery
compartment.
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Once the receiver is turned on, the receiver board will detect
the SDHC card and it will be ready to use as needed.

Installing the SIM Card

The SIM card provides access to communication over GSM,
GPRS, or CDMA services. The SIM card must support
Circuit Switched Data to communicate directly between
receivers. The SIM card must have GPRS support to
communicate over a TCP/IP network.

1. Ensure the receiver is turned off.
2. Remove the battery to the right of the MINTER.

Topcon GR-5 Quick Start Guide
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3. Carefully insert the SIM card, label side up, into the
SIM card slot located at the top of the battery
compartment.

Once the receiver is turned on, the receiver board will detect
the SIM card and it will be ready to use as needed.

Installing the Batteries

Attaching the Batteries
To attach the batteries to the GR-5:

1.  With the battery slightly tipped, place the bottom of the
battery into the bottom of the battery compartment.
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2. Gently push the top of the battery into the battery
compartment until it snaps into place. Make sure that the
clip at the top of the battery completely snaps into place.

S
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Detaching the Batteries

To detach the batteries from the GR-5, so that they can be
charged or replaced:

Using the clip at the top of the battery, gently pull down and
out to detach the battery from the receiver.

Charging the Batteries

You can charge the batteries using the power supply unit or
the battery charging cradle.

A 6-hour charge cycle will fully charge the batteries; the
batteries charge simultaneously.

The Li-Ion batteries used in the battery packs should run at

no less than 80% capacity after 500 charging cycles. These
batteries do not need to be drained before recharging.
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Charging with the Power Supply Unit

@ CAUTION

The power supply unit is designed for
indoor use only. Do not use it in damp or
wet environment. Do not expose the power
supply to rain or snow. It should only be
used for charging the batteries. Do not use
as a power source during surveying.

The power supply unit can be connected to the charging
cradle or directly to the GR-5. The power supply has the
following specifications:

* input voltage — between 100 and 240 V AC
* frequency of input power — between 50 Hz and 60 Hz
e output voltage — 12 VDC@2.5 A 30 W)
To charge the attached batteries using the power supply unit:
1. Plug the receiver-to-SAE power cable into the
receiver’s power input port.
2. Connect the receiver-to-SAE power cable and the
power-to-outlet cable to the AC adapter.
3. Plug the power supply-to-outlet cable into an available
outlet.

Topcon GR-5 Quick Start Guide
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Charging with the Battery Charging Cradle
1. Remove the batteries from the receiver and insert them
into the charging cradle.
Connect the power cable to the power supply unit.

3. Connect the SAE connectors on the power adapter cable
and power supply unit.

4. Connect the power adapter cable to one of the ports on
the charging cradle (either port will charge both/either
battery).

5. Plug the power supply to an available outlet.

Charging Temperatures
Charge the batteries only in temperatures between
32°F (0°C) and 113°F (45°C). This is important to prevent
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serious damage to the batteries, the receiver or injury to
persons.

An optimal charging temperature is between 50°F (10°C)

and 77°F (25°C). If possible, charge the batteries within this
temperature range.

Estimated Operating Times

Common Conditions: Bluetooth = on; 10-12 SV tracked; using the
detachable batteries; room temperature

For the GR-5 with FH915+ Modem

Receive only mode 14 hours
250mW transmission mode 12 hours”
I'W transmission mode 10 hours”
GSM/GPRS in urban areas 13 hours
For the GR-5 with Digital Modem

Receive only mode 14 hours
0.5W transmission mode 12 hours”
I'W transmission mode 9 hours”
GSM/GPRS in urban areas 12 hours
For the GR-5 with Satel Modem

Receive only mode 14 hours
0.5W transmission mode 12 hours”

Topcon GR-5 Quick Start Guide



Connecting the GR-5 with a Control Device

1W transmission mode 11 hours™

GSM/GPRS in urban areas 12 hours

Common Conditions: 10-12 SV tracked; using the detachable batteries;
room temperature

For the GR-5 with Any Modem
Modem off 20 hours

Common Conditions: 10-12 SV tracked; using the battery shells and
AA batteries; room temperature

For the GR-5 with Any Modem
Modem off | 2.5 hours

*_ At 1 Hz correction rate, charger off.

Connecting the GR-5 with a Control
Device

You can connect the GR-5 with a computer or hand-held
controller to configure, manage files, or maintain the
receiver.

Topcon’s TRU and PC-CDU software products provide an
interface for various configuration, monitoring, and
management functions for the receiver.

TopSURYV field software is used for surveying, common
layout, and GIS purposes and is available for hand-held
controllers.

The following connection methods are available:

P/N 7010-1022 www.topconpositioning.com




Getting Started

e an RS232 cable and a computer/controller
* a Bluetooth-enabled external device (computer/
controller)

* a USB cable and a computer/controller with the TPS
USB driver installed (for PC-CDU only)

Establishing an RS232 Cable
Connection
This section shows you how to connect the GR-5 and a

computer/controller running TRU. See “RTK Survey” on
page 42 for TopSURYV connection details.

1. Using the RS232 cable, connect the serial port of the
computer/controller to the receiver’s serial port.

2. Press the power buttons on the receiver and computer/
controller to turn them on.

3. Start TRU on your computer/controller.

4. Select Device » Application Mode » Receiver
Managing.

5. Click Device » Connect.

6. On the Connection Parameters dialog box, select the
following parameters:

* Connect Using — select Serial Port

* Port name — shows physical and friendly name for
the port. The Application remembers the last used
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Establishing an RS232 Cable Connection

transport, and the last successful port/device name
for every transport, so it is easy to connect to the
same device.
* If necessary, use the list button on the right of the
Port name field to choose a port from the Select a
Port dialog.
7. Click Connect.

8. Once a TRU connection with the receiver has been
established, the Tools become active and you can
continue with configuration activities.

To quit TRU, click Device » Disconnect, then

Device » Exit.
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Notes:
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Chapter 3

urveyingy

This chapter describes how to start surveying using a pair of
GR-5 receivers for post-processing and RTK.

Post-Processing Survey

Step 1: Set up the GR-5 Base

1. Install a heavy duty tripod (PN: 22-050501-01)
over a known point. You do not need universal
tribrach and tribrach adapter when working with
this tripod.

2. Attach the antenna to the modem antenna
connector. This step ensures the safety for the
modem board, even if you does not use it for
transmitting data.

You can extend the receiver operating
time for post-processing survey by turning
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off the modem board. Connect to the GR-
5 via TRU, click Receiver Settings ->
Power, and set 2 to n in the Slots area.
Note that this will also turn off Bluetooth.

3. Carefully level the tripod and tighten the screws.

4. Attach any other accessories as needed (for
example, a backup power supply).

| GR-5 Raceiver

T

e
-
—~
-
_J.

—ll
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Step 2: Set up the GR-5 Rover

1. If needed, attach the quick disconnect to the bipod/
range pole.

c@o NOTICE

Use a bipod during post-process surveys to
ensure the antenna/receiver does not move
during data logging.

2. Attach the GR-5 receiver to the quick disconnect.
Make sure the receiver locks into place.

3. Attach the antenna to the modem antenna
connector. This step ensures the safety for the
modem board, even if you does not use it for
receiving data.
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' ™ GR-5 Recevier

@ ~ Quick Disconnect (Optional)

\5/8 inch Screw

{)7 Lock

Step 3: Measure Antenna Height (for Base
and Rover)

1. Measure the antenna height above the control point
or marker, either the slant height or the vertical
height. You may either measure the vertical height
to the Antenna Reference Point (ARP) located at
the bottom of the GR-5, or measure the slant height

Topcon GR-5 Quick Start Guide



Post-Processing Survey

to the Slant Height Measurement Mark (SHMM) on
the side of the enclosure.

........................ .-

85.0mm

o q--
g 253.0mm

168mm
A = ARP to edge = 79.0
B = ARP to corner = 97.5

....... L g B

Slant Height
to Base of
Corner on

Gray Bumper

Vertical Height
to ARP

Station Marker
or
Tip of RTK Pole

2. Record the antenna height, points name, and start
time in the field notes.

Step 4: Collect Data (for Base and Rover)

1. Turn on the receiver. The STAT (status) light
(LED) initially blinks red.
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2.

Topcon

Once the receiver has locked on to one or more
satellites, the STAT light blinks green for GPS
satellites and orange for GLONASS satellites. A
short red blink indicates that the receiver has not
solved a position.

Once the short red blink is gone, the receiver has a
position and surveying can begin; wait for green
and orange lights before beginning data collection.
This ensures that the receiver has the correct date
and time, and is locked on to enough satellites to
ensure good quality data.

The process of locking on to satellites normally
takes less than one minute. In a new area, under
heavy tree canopy, or after resetting the receiver, it
may take several minutes.

To begin collecting data, press and hold the
FUNCTION key (for more than one second and
less than five seconds).

Release the FUNCTION key when the REC
(recording) LED turns green. This indicates that a
file has opened and data collection has started. The
REC LED blinks each time data is saved to the
internal memory.

When finished, press and hold the FUNCTION key
until the REC LED light goes out.
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7. To turn off the receiver, press and hold the power
key until all lights go out, then release.

Amount of Memory Required to Store a One
Hour File

Recording Interval (seconds)
#SVs
0.1 1 5 15 30
Single-frequency dual-system receiver
Memory needed to record data
6 11 MB 1.1 MB 221 KB 74 KB 37KB
10 14 MB 1.4 MB 283 KB 94 KB 47 KB
14 17 MB 1.7 MB 345 KB 115 KB 57.5 KB
18 20 MB 2MB 407 KB 136 KB 68 KB
Dual-frequency dual-system receiver
Memory needed to record data
6 17 MB 1.7 MB 347 KB 116 KB 58 KB
10 23 MB 2.3 MB 471 KB 157 KB 78.5 KB
14 29 MB 2.9 MB 595 KB 198 KB 99 KB
18 35 MB 3.5MB 720 KB 240 KB 120 KB
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RTK Survey

Step 1: Repeat Steps 1 through 3 in “Post-
Processing Survey” on page 35

q@o NOTICE

Do not turn off the modem board.

Step 2: Connect a Hand-Held Controller
You can connect the controller to the receiver with a
serial cable.
If the controller is Bluetooth® enabled, you can connect
it to the receiver wirelessly using TopSURV.
 Set the Instrument type to GPS and check the
Bluetooth option in the Connections screen of
TopSURV.
* To change the Bluetooth device that the controller
is connected to, click the Connection icon in the
upper-right corner of the main screen in TopSURV.

Step 3: Start Surveying with TopSURV

1. Create a GPS+ job. A user-friendly Wizard will
guide you through the steps to create a job
configuration.
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2. After creating a job with the desired configuration
in TopSURYV, you can begin the survey.
Job configuration settings will be applied to the
Base receiver only after starting the Base and to the
Rover receiver only after selecting a survey option.

c@o NOTICE

For more details about how to create and
configure a job, start the GR-5 as a base or
rover receiver in RTK and other survey
methods, see the TopSURV User's Manual.
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Chapter 4

ownloading Files

This chapter describes downloading GNSS data files to a
computer.

After completing a survey, download data files to a
computer for storage, post-processing, or backup. TRU and
Topcon Link both provide file managers to download files
from the receiver to a computer.

Downloading Files via Topcon Link

Topcon Link provides two options for downloading files
from a receiver: via Windows® Explorer or via the Topcon
Link interface.

..Using Windows Explorer

1. Connect your receiver and computer.

2. Open Windows Explorer and click the Topcon GNSS
Receivers folder. Right click the folder and select
Explore. The right panel of the window displays the
automatic start of searching for Topcon receivers
connected to any of the computer ports (COM and
USB).

P/N 7010-1022 www.topconpositioning.com



Downloading Files

When finished, all receivers connected to the computer
ports display.

® Topcon GNSS Receivers

File Edit Wiew Fawvorites Tools  Help

eBack - \‘_;,I L@ }_\J Seatch ‘@;Fulders
[

Address

®% Topcon GNSS Receivers
File Edit Wiew Favorites Tools  Help

@Eack - '\,_,:;I L@ f_xj Search ‘E

Falders

+ H #

Address |=-v Topcon GNSS Receivers

3. To view information about the receiver, right-click the
receiver, and select the Properties option.

% Topcon GNSS Receivers i
Edit

Properties

File Wiew  Favaorites  Tools

Q- © B3|

Address |=n.r Topcon GRSS Receivers I
4. To view the raw file, double click on the receiver.

Gzeneral l
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To import the file(s) from the receiver to a folder, select
the file(s), and copy to the folder using drag-and-drop
method.

& GR5aUSB

File Edit Wiew Favorites Tools  Help

@Back L = 'ﬁ‘ ,:.' Search |||~ Falde

...Using Topcon Link

1. Connect your receiver and computer.
2. To start Topcon Link, click the Import from Device
button on the Toolbar.

3. From the left panel of the Import from Device dialog
box, double-click Topcon Receivers.

o~ Import from Deyice

Loak, in: | g by Computer j ﬂ_

Q Mobile Device
4@ Topcon Digikal Levels
= _ |

The program automatically searches for Topcon
receivers connected to the computer ports (COM and
USB). When finished all receivers connected to the
computer ports display.
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4. In the right panel of the Import From Device window,
navigate to and select, or create, a folder to save the
files.

5. To view the collected raw file, double click (or click
Select in the pop-up menu) the receiver. To import the
file(s) from the receiver to the computer and to save in
the selected folder, highlight the file(s) and click the
double arrows.

6. The import in progress displays.

A Import from Device

Look, in; |ﬂ_| Topoon Receivers A

Downloading Files Using TRU

1. Connect the receiver to a computer and run TRU.

2. Click the File Explorer icon in the main window. The
File Explorer dialog box displays all logged raw data
files.

3. To save a file to the computer, highlight the desired file,
right click and select Download from the pop up menu.
In the Save As dialog box navigate to or create a folder
in which to download and store the file. Click the Save
button to download and save the file.
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Chapter 5

aintenance

Restoring Default Settings

Most of the settings in the GR-5 have default values, which
you may change as needed for your particular application.
You can always return the receiver to a known operating
condition by restoring its default configuration.

To restore default settings, run TRU and select
Tools » Factory Reset.

Performing Hardware Reset

You can reset the GR-5 without returning any configured
settings to their default values. It may become necessary to
reset the GR-5 to apply certain settings which require a
hardware reset or as part of troubleshooting.

To reset the receiver, run TRU and select Tools » Reset
Receiver.
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Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory

(NVRAM) holds ephemeris data, position, the current

board’s settings, such as data recording interval, elevation

masks, etc.

After clearing the NVRAM, your receiver will require some

time to collect new ephemerides and almanacs (around 15

minutes).

Clearing the NVRAM will also reset the receiver to factory

default settings.

To clear the NVRAM using the MINTER, take the following

steps:

1. Press the power key to turn off the receiver.

2. Press and hold the FUNCTION key.

3. Press and hold the power key for about one second.
Release the power key while continuing to hold the
FUNCTION key.

4. Wait until the STAT and REC LEDs are green

Wait until the STAT and REC LEDs blink orange.

6. Release the FUNCTION key while the STAT and REC
LEDs blink orange.

To clear the NVRAM using TRU, select Tools » Clear

NVRAM.

e
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Initializing File System

The memory card in the GR-5 must be initialized before its
first use. Initializing your memory card while in the receiver
will ensure the card is formatted to the TPS proprietary file
system (TPFS). This file system allows the receiver to
create, store, retrieve, delete, and restore the raw data files.
It is also advisable to reinitialized the memory card
periodically (e.g., quarterly). This will erase any data on the
card, check for bad blocks, and set it up afresh.

To initialize the file system, run TRU, select File Explorer,
right-click (on a computer) or click and hold (on a controller)
within the file list on the Files tab and select Initialize File
System.

Initializing the file system of a connected receiver will erase
all of the receiver’s data files.

Managing Receiver Options

The Option Authorization File enables certain functions,
features, and options in the receiver, such as the following:

* the type of signal (L1, L1/L2, and so on) the receiver
processes

* the amount of data the receiver stores in the memory
* multipath reduction technology

For a complete list of available options and details, consult
with a TPS dealer.
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Checking the Receiver’s OAF using TRU

1.

Connect the receiver to a computer/controller and
run TRU.

Click the Options icon in the main window. The

Receiver Options dialog box displays that allows

the user to view the current authorization options

and upload new ones.

Loading an OAF using TRU

1.

Topcon

Connect the receiver to a computer/controller, run
TRU, and select Options.

Click Upload OAF at the bottom of the Receiver
Options dialog box.

Navigate to the location of the new Option
Authorization File. OAFs have .jpo or .tpo
extensions and are unique to each receiver.

Select the appropriate file and click Upload to the
Receiver. The new receiver option loads onto the
receiver and the Option Manager table updates.
When finished, click Save Profile on the Receiver
Options dialog box, then click File » Disconnect to
prevent conflicts with serial port management.
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Deleting Files from the Internal

Memory Card

A memory card holds a finite amount of collected data. To

free up space for more or new data, delete old data.

1. Connect the receiver to a computer/controller and run
TRU.

2. Click the File Explorer icon in the main window.

3. Highlight a desired file in the File Explorer dialog box,
right-click (on a computer) or click and hold (on a
controller) and select Delete from the pop-up menu.
Click Yes to confirm the deletion.

Recovering Deleted Files

The TPS file system is designed to allow you to recover
deleted files. The operation is easy, fast, and secure without
the need for a data recovery software.

1. Connect the receiver to a computer/controller and run
TRU.

Click the File Explorer icon in the main window.

3. Right-click (on a computer) or click and hold (on a
controller) within the file list on the Files tab and select
Mode of operation » Deleted Files Recovery.

The receiver starts remounting the file system for
displaying deleted files. During this process the REC
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LED blinks orange. Once the file system is successfully
remounted, the REC LED stops blinking and the deleted
files will appear in the list of existing files.

&> NOTICE

In this mode, only the deleted file(s) will
display.

To restore the file system to its normal state, select Mode of
operation » Normal.

Activating Sleep Mode

You can put the GR-5 into a dormant state to minimize
power consumption without turning off the receiver
completely. In sleep mode, the power board and Bluetooth
module continue to draw a small amount of power from the
batteries, causing the batteries to slowly drain over time.

1. Turn on the receiver.

2. Press the receiver’s power key for more than four
seconds and less than eight seconds. The STAT LED
will be orange. The receiver enters Sleep Mode.

You can awaken the receiver by turning it on manually or by

sending any number of characters on one of the receiver’s

serial ports.
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Loading New Firmware

Receiver GNSS firmware is released as a compressed file
that the user download and decompress. This file contains
the following three files:

¢ ramimage.ldr — the Receiver board RAM file
* main.ldp — the Receiver board Flash file
* powbrd.ldr — the Power board RAM file
To upload firmware files to GR-5 receiver, follow the steps
below:
1. Connect the receiver to a computer and run TRU.
2. Click the Firmware Loader icon in the main window.

3. Select “Receiver/Modem” in the Device field of the
Upload Firmware window.

4. Set the Capture Method to “Soft Break”
(recommended). Browse for and select the receiver
board’s RAM file and Flash file.

5. Click Start to upload the selected files.

6. Click OK to complete uploading new firmware to the
receiver.
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Chapter 6

roubleshooting

This chapter provides general tips for diagnosing and solving
some common problems you may encounter while using the
GR-5. For more in-depth troubleshooting, see the GR-5
Operator’s Manual.

Check This First!

Before contacting Topcon Technical Support, check the
following:

* Check all external receiver connections carefully to
ensure correct and secure connections. Double check for
worn or defective cables.

* Check all power sources for drained batteries or
incorrectly connected batteries/cables.

* Check that the most current software is downloaded
onto the computer/controller and that the most current
firmware is loaded into the receiver. Check the TPS
website for the latest updates.

* If connecting via Bluetooth, check that the receiver port
used for connection is in Command mode.
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Then, try the following:

* Reset the receiver (“Performing Hardware Reset” on
page 49).

» Restore default settings (“Restoring Default Settings”
on page 49).

¢ Clear the NVRAM (“Clearing the NVRAM” on
page 50).

* Initialize the file system (“Initializing File System” on
page 51). This will erase all files inside the receiver.

If the problem persists, see the following sections for other
solutions.

TX RX LED Blink Pattern on Error
Conditions

For internal FH915+/UHF modems: the TX RX LED flashes
red.

¢ A fault condition has been detected.

— Check that the radio modem’s antenna is
undamaged.

— Contact a dealer to replace the antenna.

— Check that the radio modem’s antenna is securely
and properly connected to the antenna connector.

— Move the antenna/receiver away from conducting
objects (such as, large metal objects).
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* The cable is damaged.
— Use an undamaged cable.
— Contact a Dealer to replace the cable.
For internal GSM/GPRS modems: the TX RX LED flashes
orange.
* The Rover uses the wrong PIN code, or no PIN code
was selected.
1. In TopSURY, click Job » Config » Survey.

2. Click the “...” (continue) button and press Next to
navigate to the Rover Radio configuration screen.

3. Press Configure GSM.
4. Select the PIN of the Base Station and press OK.
¢ An initialization error has occurred.

— Check that the radio modem’s antenna is
undamaged.

— Check that the radio modem’s antenna is securely
and properly connected to the antenna connector on
the radome.

— Contact a Topcon dealer to replace the antenna.
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Obtaining Technical Support

End-users

The U.S., Canada, and international TPS equipment
users are encouraged to contact your local Topcon
dealer.

Your dealer is the focal point of contact for all post-
sales technical questions and issues.

Dealers (in the U.S., Canada, Australia)

Topcon dealers can contact Topcon Technical Support
via the password-protected Help Desk, phone, and
email.

Help Desk

To contact Topcon Technical Support via the Help
Desk, visit TechnicalSupport.Topcon.com/User.

Phone

To contact Topcon Technical Support by phone,
call:

866-4Topcon or 1-866-486-7266
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Email
To contact Topcon Technical Support via email,
use the following electronic mail address:

support@topconsokkia.com

Dealers (International)

Visit http://www.topcon.co.jp/en/positioning/network/
for contact details in your region.

Dealers in Europe must contact Topcon Technical
Support via http://support.topcon-positioning.eu/.
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